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1 What you need to know before you read this document 

This tutorial assumes the following: 

 

 You are familiar with the material in the TReK Getting Started User Guide (TREK-

USER-001), the TReK Command Tutorial (TREK-USER-020), and the TReK 

Command Applications Tutorial (TREK-USER-021).  

 

 You are familiar with the following material in the TReK Command .Net Application 

Programming Interface Reference Manual (TREK-USER-048): 

 Uplink_POIC_Command Function Description 

 

 You are an average C# programmer. 

 

 You have some experience with Microsoft Visual C# .NET. 

 

 You know how to start the TReK Command Processing application, add a destination 

to the list, and activate the destination.  (See TReK Command Processing User Guide 

TREK-USER-023.) 

 

 You know how to start the TReK Command Trainer application, add a trainer to the 

list, and activate.  (See TReK Command Applications Tutorial (TREK-USER-021)). 

 

If you are uncomfortable with any of the items listed above, some of the terminology and 

concepts presented in this tutorial may be difficult to understand. 

 

 

2 Technical Support 

If you are having trouble installing the TReK software or using any of the TReK software 

applications, please try the following suggestions: 

 

Read the appropriate material in the manual and/or on-line help. 

 

Ensure that you are correctly following all instructions. 

 

Checkout the TReK Web site at http://trek.msfc.nasa.gov/ for Frequently Asked 

Questions. 

 

If you are still unable to resolve your difficulty, please contact us for technical assistance: 

 

TReK Help Desk E-Mail, Phone & Fax: 

 

E-Mail:  trek.help@nasa.gov 

Telephone:  256-544-3521 (8:00 a.m. - 4:30 p.m. Central Time) 
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Fax:   256-544-9353 

 

TReK Help Desk hours are 8:00 a.m. – 4:30 p.m. Central Time Monday through Friday.  

If you call the TReK Help Desk and you get a recording please leave a message and 

someone will return your call.  E-mail is the preferred contact method for help.  The e-

mail message is automatically forwarded to the TReK developers and helps cut the 

response time. 

 

 

3 Introduction 

This tutorial will show you how to use the TReK .NET Application Programming 

Interface (API) to send data from a Visual C# Windows Application.  The Windows 

Application that you will build performs the following tasks: 

 

 Send a fixed command at the press of a button. 

 

The CommandExample project files that match the finished version of this tutorial can be 

found in the TReK installation directory under 

\examples\VisualC#.NET\CommandExample directory.  These files can be a good 

resource if you want to copy and paste the source code instead of typing it in from 

scratch.  These files also provide an easy way to verify that you have entered the correct 

information.  For example if you run into a compile error, check the example files and 

compare them to your own. 

 

Remember to perform incremental saves as you work through the tutorial.  You never 

know when there’s going to be a power outage.   

 

Well that’s about it – Have Fun! 
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4 Step-By-Step 

 

1. Start the Visual Studio .NET Application. 

 

2. Go to the File menu, mouse over New and select Project… 

 

3. On the left side of the New Project dialog click the Visual C# folder.  You will be 

creating a Windows Application.  Select Windows Application (in Visual Studio 

2010 this will say Windows Forms Application).  On the bottom of the dialog 

you must enter the project Name (CommandExample) and Location (C:\ 

CommandExample).  You can choose a different directory if you wish.  After you 

have entered this information your dialog should look like the one in Figure 1.  

Once you are finished push OK.   

 

 

 
 

Figure 1 New Project Dialog Box 
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4. In order to use the TReK Application Programming Interface (API) library you 

need to tell Visual Studio that you want this library to be linked into your 

application.  The next few steps you perform will tell Visual Studio that you want 

to link in the TReK API library.   

 

5. First you need to copy the trek_command_dotnet_api.dll file into your project 

directory.  This file is located in the TReK installation directory under lib\.  Copy 

the trek_command_dotnet_api.dll file into your CommandExample project 

directory (C:\CommandExample\ CommandExample or the directory you chose). 

 

6. In Visual Studio, go to the Project menu and select Add Reference.  The dialog 

shown in Figure 2 will appear.  Select the Browse tab. Select 

trek_command_dotnet_api.dll.  Figure 2 shows an example of what your dialog 

should look like now.  When you’re done push the OK button to exit the dialog. 

 

 

Figure 2  Add Reference Dialog 
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7. Go to the Project menu again and select CommandExample (name of your 

project) properties…. On the Build tab make sure the Platform target is set to 

x86. This library is only designed for use on x86 systems (See Figure 3). 

 

 

Figure 3 Setting Platform Target 

 

 

8. If you are using Visual Studio 2008 or greater you will need to perform this 

step. In the Solution Explorer select CommandExample, right click and select 

Add, and then select New Item. The item to add is an Application Configuration 

File (see Figure 4).  

 

Figure 4 Adding Application Configuration File 
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Inside the configuration file insert the following 

If you are using Visual Studio 2008: 
<?xml version="1.0" encoding="utf-8" ?> 

<configuration> 

  <startup useLegacyV2RuntimeActivationPolicy="true"> 

    <supportedRuntime version="v2.0.50727"/> 

  </startup> 

</configuration> 

 

If you are using Visual Studio 2010: 
<?xml version="1.0" encoding="utf-8" ?> 

<configuration> 

  <startup useLegacyV2RuntimeActivationPolicy="true"> 

    <supportedRuntime version="v4.0"/> 

  </startup> 

</configuration> 

 

 

 

9. Now you need to add the source code for your command example.  Right click on 

the Form1.cs and select Rename. Type in CommandExample.cs and answer yes 

(see Figure 5) to the popup. Next update the CommandExample.cs code. To 

access the code select the CommandExample.cs file, right click and select View 

Code. (Note: the CommandExample.Designer.cs and CommandExample.resx 

(may appear in some versions of Visual Studio) files are auto generated by Visual 

Studio and should not need to be edited by the user.) You can either replace the 

source code in your CommandExample.cs file with the code in Appendix A or 

you can type in the code yourself.  If you choose to type in the code there are two 

sections you will need.  The first is at the beginning of the file and is marked with 

comments called “System Include Files” and “TReK Include Files.”  The second 

section is marked with a comment called “TReK CommandExample Example 

Code Begins Here.”  

 

 

 

Figure 5 Popup to Acknowledge File Name Change 

 

10. Now you are ready to compile and build your computation.   Go to the Visual 

Studio Build menu and select Build Solution.  If you run into any compile errors 

that you cannot easily solve, compare your code to the finished product in the 
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examples directory in the TReK installation to locate any inconsistencies.  If you 

encounter any Linking errors this may mean Visual Studio is having trouble 

locating the trek_command_dotnet_api.dll file.  Make sure this file is in your 

CommandExample project directory and added as a reference (see step 6). 

 

11. Before you run the CommandExample, you need to set up your TReK system so 

the POIC destination is activated.  To set up your TReK system for the POIC 

destination, perform the following steps: 

a. Start the Command Trainer application. 

b. Add POIC trainer. 

c. Activate POIC trainer. 

d. Start the Command Processing application. 

e. Add POIC destination. 

f. Activate POIC destination 

 

After you have performed the steps above, go to the Visual Studio Debug menu and 

choose Start Without Debugging to run the CommandExample.  Your application will 

send the command each time the button is pressed.  When you write a program, you will 

probably add quite a bit more error checking than was shown in this tutorial.  In this 

tutorial, these checks were not performed in order to make the program as simple as 

possible.  Please see the TReK Command .NET Application Programming Interface 

Reference Manual for more information about API return codes and what they mean. 
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Appendix A CommandExample Source Code 
//Start System Include Files 

using System; 

using System.Collections.Generic; 

using System.ComponentModel; 

using System.Data; 

using System.Drawing; 

using System.Text; 

using System.Windows.Forms; 

//End System Include Files 

//Start TReK Include Files 

using trek; 

//End TReK Include Files 

 

//TReK CommandExample Example Code Begins Here 

namespace CommandExample 

{ 

    public partial class CommandExample : Form 

    { 

        TextBox tbReturn; 

        public CommandExample() 

        { 

            InitializeComponent(); 

 

            this.Text = "Command Example"; 

            this.Size = new Size(525, 100); 

            this.ShowIcon = false; 

            this.MaximumSize = new Size(525, 100); 

            this.MinimumSize = new Size(525, 100); 

            this.MaximizeBox = false; 

            this.Show(); 

 

            tbReturn = new TextBox(); 

            tbReturn.Location = new Point(2, 2); 

            tbReturn.Size = new Size(500, 5); 

            tbReturn.Text = "Waiting for return code"; 

 



TREK-USER-046 

9 

 

            Button sendCmd = new Button(); 

            sendCmd.Text = "Uplink TEST_SWITCH CMD"; 

            sendCmd.Location = new Point(150, 30); 

            sendCmd.Size = new Size(200, 25); 

            sendCmd.Click += new System.EventHandler(sendCommand); 

 

            this.Controls.Add(sendCmd); 

            this.Controls.Add(tbReturn); 

        } 

 

        private void sendCommand(object sender, EventArgs e) 

        { 

            //Create and initialize variables 

            int return_code = 0;                    // Return code from TReK API 

            string destination = "POIC";            // Destination name in the Command Processing window 

            string command_name = "TEST_SWITCH";    // Command mnemonic 

            string message;                         // Will get the return code as a string value 

 

            //Make call to the command processing application 

            return_code = trek_cmd_user_api.Uplink_POIC_Command(destination, command_name); 

 

            //Check return to see if command sent successfully 

  //if(return_code == 0) //You can use this if you don’t wish to use the TREK_ERROR class 

          //Just comment out the line below 

            if (return_code == (int)TREK_CMD_API_RETURN_CODES.cmd_API_SUCCESS) 

            { 

                tbReturn.Text = "Command successfully sent"; 

            } 

            else 

            { 

                tbReturn.Text = "Error sending command"; 

            } 

        } 

    } 

} 

//    End of TReK Computation Example Code



TREK-USER-046 

10 

 

 

 

Appendix B Glossary 
Note:  This Glossary is global to all TReK documentation.  All entries listed may not be 

referenced within this document. 

 

Application Programming Interface 

(API) 

A set of functions used by an application program 

to provide access to a system’s capabilities. 

 

Application Process Identifier 

(APID) 

An 11-bit field in the CCSDS primary packet 

header that identifies the source-destination pair 

for ISS packets. The type bit in the primary header 

tells you whether the APID is a payload or system 

source-destination. 

 

Calibration The transformation of a parameter to a desired 

physical unit or text state code. 

 

Communications Outage Recorder System that captures and stores payload science, 

health and status, and ancillary data during TDRSS 

zone of exclusion. 

 

Consultative Committee for Space  

Data Systems (CCSDS) format 

Data formatted in accordance with 

recommendations or standards of the CCSDS. 

 

Consultative Committee for Space  

Data Systems (CCSDS) packet 

A source packet comprised of a 6-octet CCSDS 

defined primary header followed by an optional 

secondary header and source data, which together 

may not exceed 65535 octets. 

 

Conversion Transformation of downlinked spacecraft data 

types to ground system platform data types. 

 

Custom Data Packet A packet containing a subset of parameters that 

can be selected by the user at the time of request. 

 

Cyclic Display Update Mode A continuous update of parameters for a particular 

display. 

 

Decommutation (Decom) Extraction of a parameter from telemetry. 

 

Discrete Values Telemetry values that have states (e.g., on or off). 
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Dump During periods when communications with the 

spacecraft are unavailable, data is recorded 

onboard and played back during the next period 

when communications resume.  This data, as it is 

being recorded onboard, is encoded with an 

onboard embedded time and is referred to as dump 

data. 

 

Enhanced HOSC System (EHS) Upgraded support capabilities of the HOSC 

systems to provide multi-functional support for 

multiple projects. It incorporates all systems 

required to perform data acquisition and 

distribution, telemetry processing, command 

services, database services, mission support 

services, and system monitor and control services. 

 

Exception Monitoring A background process capable of continuously 

monitoring selected parameters for Limit or 

Expected State violations. Violation notification is 

provided through a text message. 

 

Expected State Sensing Process of detecting a text state code generator in 

an off-nominal state. 

 

EXPRESS An EXPRESS Rack is a standardized payload rack 

system that transports, stores and supports 

experiments aboard the International Space 

Station. EXPRESS stands for EXpedite the 

PRocessing of Experiments to the Space Station. 

 

File transfer protocol (ftp) Protocol to deliver file-structured information from 

one host to another. 

 

Flight ancillary data A set of selected core system data and payload 

health and status data collected by the USOS 

Payload MDM, used by experimenters to interpret 

payload experiment results. 
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Grayed out Refers to a menu item that has been made 

insensitive, which is visually shown by making the 

menu text gray rather than black.  Items that are 

grayed out are not currently available. 

 

Greenwich Mean Time (GMT) The solar time for the meridian passing through 

Greenwich, England.  It is used as a basis for 

calculating time throughout most of the world. 

 

Ground ancillary data A set of selected core system data and payload 

health and status data collected by the POIC, 

which is used by experimenters to interpret 

payload experiment results.  Ground Ancillary 

Data can also contain computed parameters 

(pseudos). 

 

Ground receipt time Time of packet origination. The time from the 

IRIG-B time signal received. 

 

Ground Support Equipment (GSE) GSE refers to equipment that is brought in by the 

user (i.e. equipment that is not provided by the 

POIC). 

 

Ground Support Equipment Packet A CCSDS Packet that contains data extracted from 

any of the data processed by the Supporting 

Facility and the format of the packet is defined in 

the Supporting Facility’s telemetry database. 

 

Huntsville Operations Support 

Center (HOSC) 

A facility located at the Marshall Space Flight 

Center (MSFC) that provides scientists and 

engineers the tools necessary for monitoring, 

commanding, and controlling various elements of 

space vehicle, payload, and science experiments. 

Support consists of real-time operations planning 

and analysis, inter- and intra-center ground 

operations coordination, facility and data system 

resource planning and scheduling, data systems 

monitor and control operations, and data flow 

coordination. 
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IMAQ ASCII A packet type that was added to TReK to support a 

very specific application related to NASA’s Return 

to Flight activities.  It is not applicable to ISS.  It is 

used to interface with an infrared camera that 

communicates via ASCII data. 

 

Limit Sensing Process of detecting caution and warning 

conditions for a parameter with a numerical value. 

 

Line Outage Recorder Playback A capability provided by White Sands Complex 

(WSC) to play back tapes generated at WSC 

during ground system communication outages. 

 

Measurement Stimulus Identifier 

(MSID) 

Equivalent to a parameter. 

 

 

Monitoring A parameter value is checked for sensing 

violations. A message is generated if the value is 

out of limits or out of an expected state. 

Parameter TReK uses the generic term parameter to mean any 

piece of data within a packet.  Sometimes called a 

measurement or MSID in POIC terminology. 

 

Payload Data Library (PDL) An application that provides the interface for the 

user to specify which capabilities and requirements 

are needed to command and control his payload. 

 

Payload Data Services Systems 

(PDSS) 

The data distribution system for ISS.  Able to route 

data based upon user to any of a number of 

destinations. 

 

Payload Health and Status Data Information originating at a payload that reveals 

the payload’s operational condition, resource 

usage, and its safety/anomaly conditions that could 

result in damage to the payload, its environment or 

the crew. 

 

Payload Operations Integration 

Center (POIC) 

Manages the execution of on-orbit ISS payloads 

and payload support systems in 

coordination/unison with distributed International 

Partner Payload Control Centers, Telescience 

Support Centers (TSC’s) and payload-unique 

remote facilities. 
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Payload Rack Checkout Unit 

(PRCU) 

The Payload Rack Checkout Unit is used to verify 

payload to International Space Station interfaces 

for U.S. Payloads. 

 

Playback Data retrieved from some recording medium and 

transmitted to one or more users. 

 

Pseudo Telemetry (pseudo data) Values that are created from calculations instead of 

directly transported telemetry data.  This pseudo 

data can be created from computations or scripts 

and can be displayed on the local PC. 

 

Remotely Generated Command A command sent by a remote user whose content 

is in a raw bit pattern format.  The commands 

differ from predefined or modifiable commands in 

that the content is not stored in the POIC Project 

Command Database (PCDB). 

 

Science data Sensor or computational data generated by 

payloads for the purpose of conducting scientific 

experiments. 

 

Subset A collection of parameters from the total 

parameter set that is bounded as an integer number 

of octets but does not constitute the packet itself.  

A mini-packet. 

 

Super sampled A parameter is super sampled if it occurs more 

than once in a packet. 

 

Swap Type A flag in the Parameter Table of the TReK 

database that indicates if the specified datatype is 

byte swapped (B), word swapped (W), byte and 

word swapped (X), byte reversal (R), word 

reversal (V) or has no swapping (N). 

 

Switching A parameter’s value can be used to switch between 

different calibration and sensing sets.  There are 

two types of switching on TReK:  range and state 

code. 
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Transmission Control Protocol 

(TCP) 

TCP is a connection-oriented protocol that 

guarantees delivery of data. 

 

Transmission Control Protocol 

(TCP) Client 

A TCP Client initiates the TCP connection to 

connect to the other party. 

 

Transmission Control Protocol 

(TCP) Server 

A TCP Server waits for (and accepts connections 

from) the other party. 

 

Telemetry Transmission of data collected form a source in 

space to a ground support facility. Telemetry is 

downlink only. 

 

Telescience Support Center (TSC) A TSC is a NASA funded facility that provides the 

capability to plan and operate on-orbit facility 

class payloads and experiments, other payloads 

and experiments, and instruments. 

 

User Application Any end-user developed software program that 

uses the TReK Application Programming Interface 

software.  Used synonymously with User Product. 

 

User Data Summary Message 

(UDSM) 

Packet type sent by PDSS that contains 

information on the number of packets sent during a 

given time frame for a PDSS Payload packet.  For 

details on UDSM packets, see the POIC to Generic 

User IDD (SSP-50305). 

 

Uplink format The bit pattern of the command or file uplinked. 

 

User Datagram Protocol (UDP) UDP is a connection-less oriented protocol that 

does not guarantee delivery of data.  In the TCP/IP 

protocol suite, the UDP provides the primary 

mechanism that application programs use to send 

datagrams to other application programs.  In 

addition to the data sent, each UDP message 

contains both a destination port number and a fully 

qualified source and destination addresses making 

it possible for the UDP software on the destination 

to deliver the message to the correct recipient 

process and for the recipient process to send a 

reply. 
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User Product Any end-user developed software program that 

uses the TReK Application Programming Interface 

software. Used synonymously with User 

Application. 

 

Web Term used to indicate access via HTTP protocol; 

also referred to as the World Wide Web (WWW). 
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Appendix C Acronyms 
Note:  This acronym list is global to all TReK documentation.  Some acronyms listed 

may not be referenced within this document. 

 

AOS   Acquisition of Signal 

API   Application Programming Interface 

APID   Application Process Identifier 

ASCII   American Standard Code for Information Interchange 

CAR   Command Acceptance Response 

CAR1   First Command Acceptance Response 

CAR2   Second Command Acceptance Response 

CCSDS  Consultative Committee for Space Data Systems 

CDB   Command Database 

CDP   Custom Data Packet 

COR   Communication Outage Recorder 

COTS   Commercial-off-the-shelf 

CRR   Command Reaction Response 

DSM   Data Storage Manager 

EHS   Enhanced Huntsville Operations Support Center (HOSC) 

ERIS   EHS Remote Interface System 

ERR   EHS Receipt Response 

EXPRESS  Expediting the Process of Experiments to the Space Station 

ES   Expected State 

FAQ   Frequently Asked Question 

FDP   Functionally Distributed Processor 

FSV   Flight System Verifier 

FSV1   First Flight System Verifier 

FSV2   Second Flight System Verifier 

FPD   Flight Projects Directorate 

FTP   File Transfer Protocol 

GMT   Greenwich Mean Time 

GRT   Ground Receipt Time 

GSE   Ground Support Equipment 

HOSC   Huntsville Operations Support Center 

ICD   Interface Control Document 

IMAQ ASCII  Image Acquisition ASCII 

IP   Internet Protocol 

ISS   International Space Station 

LDP   Logical Data Path 

LES   Limit/Expected State 

LOR   Line Outage Recorder 

LOS   Loss of Signal 

MCC-H  Mission Control Center – Houston  

MOP   Mission, Operational Support Mode, and Project 

MSFC   Marshall Space Flight Center 

MSID   Measurement Stimulus Identifier 
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NASA   National Aeronautics and Space Administration 

OCDB   Operational Command Database 

OS   Operating System 

PC   Personal Computer, also Polynomial Coefficient 

PCDB   POIC Project Command Database 

PDL   Payload Data Library 

PDSS   Payload Data Services System 

PGUIDD  POIC to Generic User Interface Definition Document 

POIC   Payload Operations Integration Center 

PP   Point Pair 

PRCU   Payload Rack Checkout Unit 

PSIV   Payload Software Integration and Verification 

RPSM   Retrieval Processing Summary Message 

SC   State Code 

SCS   Suitcase Simulator 

SSP   Space Station Program 

SSCC   Space Station Control Center 

SSPF   Space Station Processing Facility 

TCP   Transmission Control Protocol 

TReK   Telescience Resource Kit 

TRR   TReK Receipt Response 

TSC   Telescience Support Center 

UDP   User Datagram Protocol 

UDSM   User Data Summary Message 

URL   Uniform Resource Locator 

USOS   United States On-Orbit Segment 

VCDU   Virtual Channel Data Unit 

VCR   Video Cassette Recorder 

VPN   Virtual Private Network 

 

 


